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1 Introduction 
With the latest advancements in technology and the lowering cost of computers, 
it has never been easier to make high quality recordings on your computer for 
little or no cost. Previously to make a recording you could either recording it 
yourself on a low quality analog 4-track recorder, or spend $$$ per hour in a 
recording studio for a good recording. With a home studio set up you have the 
best of both worlds, reasonable quality recordings for a reasonable price. Best of 
all there are no time constraints. You can take your time to get everything 
recorded just right.  
 
Anybody can do this. All you need is a computer running Windows, MacOS, or 
even Linux. The high quality and ease of use of hardware and software has 
made it possible for anybody to record their music and distribute and even sell it 
on the internet.   
 
This book shows you how to use your computer to record, edit and master your 
recording. Step-by-step processes are shown to help you make that perfect 
recording through to processing and mixing the audio to the final mastering of the 
recording.   
 
This book explains processes with a very popular open source multi-track audio 
editor called Audacity. Open source software is great because it tends to be very 
reliable and best of all it is free to use.   
 
Weather you are a solo artist, in a band or just want an introduction to digital 
audio engineering then this book is a good place to start. 
 
 

2 Checklist, what you need 
Before you start, there is some gear that you will need. Hopefully you already 
have most of this gear. Read on …. 

2.1 Computer and Sound Card 

There are a few essential items you will need for your recording project. First and 
foremost you need a computer with a soundcard. Any computer that was built in 
the last five years should be fine. Most computers built in recent years have a 
sound card built into the motherboard.  How do 
you tell if your computer has a soundcard? You 
ask. Just have a look at the back of your 
computer. You should see three little 1.5 mm 
sockets that are usually colored. The red socket 
is your microphone input. The blue is your line 
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input for devices such as guitar preamps, hardware drum machines, or any 
component that has an audio output.  And the green is your speaker or 
headphone output.  
 
 

2.2 Disk Space 

Recording projects can be pretty hungry on disk space.  You will probably be 
recording wav or aiff files for your project. These files can take up a lot of space 
on you hard drive. For example one minute of uncompressed audio can take up 
as much as 10 megabytes of disk space. Make sure you have at least 300 
megabytes free before you start your project. See the section on bit and sample 
rates, and how it relates to audio quality and file size.  
 

2.3 Multi-Track Recording Software 

You will need multi-track audio recording software. Multi-track software allows 
you to record your project layer at a time. First you can lay down your drum track. 
You can next lay down the guitar tracks and then the vocal. Commercial multi-
track recording software can cost hundreds of dollars or you can opt for free 
software that is almost as good. I use an open source package called Audacity. It 
is available for Windows, Mac OS and Linux. This book explains the process of 
recording through mastering your project using Audacity. Audacity can be 
downloaded at http://audacity.sourceforge.net/  
 

2.4 Microphone 

If you intend to record vocal and other instruments, you will need a microphone. 
Don’t assume that that just because you buy an expensive microphone that it will 
be suitable. Quality mics can actually sound worse because they can pick up 
background noise that you don’t want. This problem has more to do with the 
sound insulation and acoustics of the room. Basically for recording acoustic 
instruments, you will need an electret condenser mic. For vocals try a large 
capsule condenser mic. Having said that, try to experiment with different mics to 
see what delivers the result you are looking for.  
 
Recording live drums is a little trickier. You will need at least 3 mics and you will 
need to plug these into some kind of mixer as basic sound cards only have one 
mic input. Drum hits are loud and the mic must be able to capture this sound 
without distorting. This distortion is caused by the SPL (Sound Pressure Level) of 
the drum hit. Generally for kick and snare drums you should stick with a dynamic 
mic. And for other drums go for a condenser mic.  
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2.5 CD Writer 

If you plan on sending your demos to recording labels or radio stations, your 
better off with CDs With a CD writer you will be able to produce CDs that can be 
played on any CD player. All CD Writers come with bundled software to produce 
audio CDs. The two most popular for the windows platform are Ahead Nero and 
Easy CD Creator.  
 

2.6 Music software  

There is plenty of software available to you on the internet. These programs can 
help you to produce anything from drum loops to synth sounds. Visit this website 
for a comprehensive list of free, demo, shareware and commercial software 
http://www.hitsquad.com/smm/   
 
 

2.7 Cables and adapters 

You may need a variety of cables and adapters to connect components to your 
computer. Just about all sound cards use 1.5 mm audio input and outputs. So the 
most common cables and adapters that you are likely to need are as follows: 
 
 
 

 

Stereo 1.5 mm plug to 6.5 mm socket adapter 

Mono 1.5 mm plug to Mono 6.5 mm socket adapter 

Mono 1.5 mm plug to Stereo 1.5 mm socket adapter 

Stereo 1.5 mm plug to stereo 1.5 mm 
plug lead 

Stereo 6.5 mm plug to 1.5 mm socket adapter 

Stereo 1.5mm plug to 
RCA plug lead 

Mono 6.5 mm plug to 
Mono 6.5 mm plug lead 
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Ask yourself this question. How do I connect my amplifier/pre-
amp/microphone/organ/whatever to my computer’s sound card? The answer 
should be one or more of the above cables or adapters. 
 
 

2.8 Other hardware 

This will depend on the sort of music you make. If you’re into hip-hop you will 
probably be using a sampler, mixer and turntables. If you’re into rock you will 
have an amplifier. Check if your equipment has an audio output on it in. It should 
be in the form of either 1.5mm / 6.5 sockets (mono or stereo). Your equipment 
may have RCA outputs on it. If your equipment has these outputs then it will be 
easy to connect it to your computer and record it. Sometimes there is an audio 
output labeled headphones. You can use this as an output. 
 

2.9 Speakers 

You will need speakers when playing back your recordings. Studio speakers are 
nice to own if you can afford them. But if you can’t, then do not resort to the 
speakers that came bundled with your computer. These speakers are generally 
pretty low quality. Why not use your mini-system? Most mini-systems have a 
video or auxiliary input at the back. You can connect a cable from the speaker 
output of your sound card into the video/auxiliary inputs of your mini-system. You 
will need a 1.5mm plug to RCA plug cable for this purpose. 
 

 
 
Switch your mini-system to video or auxiliary mode. This will in most cases 
deliver an adequate representation of your recording.  
 
You will want arrange your speakers so that they are in the most ideal position. 
You need to be sitting in the middle of the left and right speakers. Your head 
should be at the same height of the speaker. Make sure you do not have 
anything in front of the speakers.  

Speaker/ Line Out Line In Microphone 

Computer’s Sound Card 
(back of computer) 

Speakers 

L R 

+ 
 
- 

R 

L 

VIDEO / 
AUX 

Back of Hi-Fi Mini System 
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2.10 Headphones 

Headphones are essential especially if you are recording from a microphone. 
The reason for this is that when the vocalist is singing along to music. You do not 
want the sound from speakers being rerecorded through the microphone. The 
vocalist can listen to music though headphones and the music will not be picked 
up by the microphone. The microphone should only be able to pick up the vocal. 
 
You will also need headphones if you do not have a decent set of speakers. 
 
I recommend using high quality studio headphones. The kind that covers the 
whole ear that has thick padding that helps keep the sound in. Remember we 
don’t want any sound spilling out back into the microphone.  
   
 

3 Step By Step Processes 
 
 

3.1 Making the connections 

3.1.1 Speakers 

Speakers can be plugged into the green output socket on your sound card.  
 

3.1.2 Microphone 

 
A microphone can be plugged directly into the microphone socket of the 
computer’s sound card. This is usually the little red socket.  If your microphone 
has a 6.5 mm plug then you need a Mono 1.5 mm plug to Mono 6.5 mm socket 
adapter. 
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3.1.3 Acoustic guitar or other non-electric instrument 

If you plan on recording a non-electric instrument such as an acoustic guitar, 
then you simply just need to record with a microphone. See above for how to 
connect the microphone.  
 
 

3.1.4 Electric guitar 

You can not connect an electric guitar directly to a computer. There are primarily 
two devices that you will use when recording an electric guitar. They are the 
amplifier and/or the preamp. Most amplifiers have an output on them. Even 
cheap practice amps. Look for a 6.5 mm socket labeled output. If you don’t have 
this, then look for one labeled headphones. You need to connect this to the line 
input of your sound card. This is the little blue socket. You will need a stereo 6.5 
mm plug to Stereo 1.5 mm socket combined with a Stereo 1.5 mm plug to 1.5 
mm plug lead. Note that the diagram does not show this adapter. Connect the 
guitar to the amp in the usual way.  
 
Guitar � Amp � Soundcard 
 

Speaker/ Line Out Line In Microphone 

Computer’s Sound Card 
(back of computer) 

Speaker/ Line Out Line In Microphone 

Computer’s Sound Card 
(back of computer) 

Connecting a Microphone with a 1.5mm plug to the soundcard 

Connecting a Microphone with a 6.5mm plug to the soundcard 
with 1.5 mm plug to 6.5 mm socket adapter 
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You can get by without using an amp by using your preamp or pedal effects unit. 
A preamp amplifies and/or modifies the sound before it is input into another 
device. You can connect your preamp to the computer in the same way as you 
connect an amplifier as above.  

 
 
You can also use your preamp and amp together. You would generally do this 
when you want to create a unique sound. For example you may want to plug the 
guitar into a delay pedal. Then the output of the delay pedal will be plugged into 
input of the amplifier. The output of the amplifier will be plugged into the input of 
your computer’s sound card. The results will be a distorted delay sound.   
 
Guitar � Preamp � Amp� Soundcard 

Speaker/ Line Out Line In Microphone 

Computer’s Sound Card 
(back of computer) 

 
 
Pre-amp 

Speaker/ Line Out Line In Microphone 

Computer’s Sound Card 
(back of computer) 
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Be careful when connecting your gear to the computer. There is the risk of an 
electrical spike damaging your sound card when plugging devices in.  Ways to 
avoid this are by making all of your connections while everything is turned off.  
 
Another good idea is to set the output level of your amp to a low volume before 
connecting it and switching it on.  
  

3.1.5 Connecting Other Devices 

Most electronic music equipment such as organs, synthesizers and drum 
machines are very easy to connect to a soundcard. Simply find the output socket 
of the device and use the appropriate lead to connect it to the line input of the 
sound card. Remember, it is best to make connections while everything is turned 
off with the output volume of the device is set to a low level.  
 

3.2 Connection Problems 

3.2.1  Buzzing 

This is one of the most annoying problems that you will encounter. Buzzing is 
caused by interference from other electrical devices. It can be caused by 
fluorescent lighting, your next-door neighbor’s skill saw, low quality leads and 
equipment, and ironically computers can also be the source of the buzzing.  
 
Your first step to solving this problem is to find the source of the buzz by a 
process of elimination. Try turning off non-essential appliances first.  
 
Try wriggling your connections to see if you notice any change.  
 
If you are using equipment that gives you the option of using batteries instead of 
an AC to DC power transformer, then use batteries. I learned this lesson the hard 
way. When I started learning guitar, I used a $200 Stratocaster copy. I was using 
a power transformer for my preamp. I was convinced that the buzz was caused 
by the cheap guitar. I found an article on the internet which described how to 
rewire a Stratocaster to eliminate this buzz. Three hours later the problem was 
not solved. I tried using batteries in my preamp. Problem solved. 
Some power boards have circuitry inside that helps to eliminate buzzing, 
however I have had limited success with those.   
 

3.2.2 Intermittent Sound 

This is most likely to be caused by a loose connection somewhere between your 
instrument and the computer. Again use the process of elimination to find where 
the problem is. Try using alternative leads. If this does not help, try using 
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alternative equipment. Also try cleaning the insides of sockets and the outside of 
the plug.  
 

3.2.3 No Sound 

This is most likely caused by your computers mixer settings. See the chapter 
below about this. The other cause for this problem may be a permanently broken 
cable.  
 

3.3 Mixer Settings 

The mixer settings on your computer are used to control the input and output 
volumes of your sound card. You may find that you have no sound from either 
your microphone or other device plugged into the line input. To access the mixer 
settings on a Windows PC do the following: 
 

3.3.1 Play Mixer Settings.  

In this section you will be able to set up your mixer so that anything you plug into 
your sound card will be able to be heard. Follow the steps below or refer to your 
sound cards manual. 
 

1. Double click the speaker Icon on the bottom right-hand side of your 
screen. It’s usually next to the time.  

2. Click the options menu 
3. Click properties 

 
4. Choose your sound card for the mixer device. 
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5. Make sure at least ‘Microphone’, ‘Line-In’, ‘Wave’, and ‘Play Control’ are 
selected 

6. Click Ok 
7. Make sure ‘Microphone’, ‘Line-In’, ‘Wave’ and ‘Play Control’ are not muted 

or at a low level.  

 
 
 

3.3.2 Record Mixer Settings 

In this section you will user the mixers record settings to choose what you want 
to record from. Follow the steps below: 
 

1. Double click the speaker Icon on the bottom right-hand side of your 
screen. 

2. Click the options menu 
3. Click properties 
4. Click the ‘Recording’ radio button 
5. Select ‘Microphone’ and ‘Line-In’ to show these devices 
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6. Choose only one recording device here. You will only want to record from 
either the ‘Microphone’ or ‘Line-In’. 

 
 
Some newer sound cards allow you to record from two devices at once. This is 
handy if you want to make a live recording from a Line Input and Microphone 
simultaneously.  But you will not be able to separate the tracks. If you are 
recording layer at a time then you will only want one recording input selected at 
one time. You don’t want to record any low level noise from other inputs if you 
can help it.  
 

3.4 Project Settings 

Before you start recording your project, you should make sure you are organized. 
There are two main things you need to consider. They are: 
 

• Where you are saving your work  
• The format you are recording in 
• The audio input / output settings 

3.4.1 Saving Projects 

Saving your project in audacity is easy. Simply choose ‘Save Project’ from the file 
menu. It is good practice to have a dedicated folder for each of your projects. 
Sometimes you will be working with several files and it is a really good idea to 
keep them in one place.  
 
Before you start a project make sure you have plenty of hard drive space. At 
least 300mb should be enough. But this really depends on the quality of the 
audio you are recording (see below about sample rates).  
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After you finish a project, you should backup your project files onto a CD-ROM or 
some other storage device. Project files can take up a lot of space. The more 
recording you do the sooner your disk space will run out. You can delete the 
project from your hard drive once your project has been backed up.  
 
 

3.4.2 Sample rates and sample formats. 

Before beginning a recording you will want to set the recording quality. Sample 
rates, bit rates are similar but different.  
 
CD quality audio is sampled at 44100 Hz. This means that for the left and right 
channel, the audio will be sampled 44100 times per second. The higher the 
sample rate, the higher the quality of audio and file size.  
 
The bit rate is also called the sample format. This describes how many bits are 
used represent each sample. CD quality audio has sample format of 16 bits. The 
higher the sample format, the higher the quality of audio and file size.  
 
Stereo and mono describes if you are using one or two channels to record the 
sound. As a general rule you will record most instruments in mono unless you 
are using multi-directional or stereo microphone. Other audio devices will 
probably need to be recorded in stereo. You can tell by looking at the connection 
as to whether or not you should be recording in stereo or mono.  
 
Because a stereo recording is represented by two channels, it will take up twice 
as much space as a normal recording.  
 
Don’t worry too much about this. I know it is a bit confusing. I suggest that you 
record at a sample rate of 44.1 Khz (44100 Hz) with a sample format of 32 bits. 
Use Mono or Stereo depending on what you are recording as mentioned above.  
 
To set up the sample rate and format in Audacity follow these steps: 
 

1. Click File Menu 
2. Click Preferences 
3. Click the Quality tab 
4. Change the top two settings. Leave the rest 

 
5. Click OK 
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3.4.3 Audio Input / Output Settings 

To set the input settings for recording and the output settings follow these steps: 
 

1. Click File Menu 
2. Click Preferences 
3. Click the Audio I/O tab 
4. Set the Playback device to your sound card.  
5. Set the Recording device to your sound card. 
6. Set the recording channels to 1 (Mono) or 2 (Stereo) 
7. Tick the box which says ‘Play other tracks while recording new one’ 
8. Click OK  

 

 
 

 

3.5 Test Recording a Microphone 

  

3.5.1 Test Recording 

Great. You have made your connections. It is time to make a test recording. The 
purpose of this is to make sure your levels are set up correctly. This is very 
important because you want to record at the highest volume without sacrificing 
quality. Follow the steps below: 
 

1. Start Audacity  
2. Choose the Microphone as the recording source. 
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3. Press the red Record Button. 

 
4. Sing into the microphone in way that you would in a normal performance. 

Consider loudness of voice and the distance you are to the microphone.  
Sing for a few seconds. 

5. Push the stop button 

 
 

3.5.2 Adjusting the levels 

We will now need to adjust the levels until they are just right. Below is an 
example of a recording where the levels were too high.  
 

 
 
What you see here is a phenomenon called clipping. The sound that was 
recorded was too loud and as result of this, the sound was clipped. Press the 
play button and you can tell this is clipped because it will sound distorted [listen 
to this and describe the sound]. Also you can tell by looking at the visual 
representation of the sound. It is flat at the top and bottom of the waveform. 
 
Okay. Now let’s reduce the input level of the Microphone. Simply adjust this 
slider control to about halfway.  
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Now we will make another test recording. But first, clear the previous recording 
that was made. Click the x on the top left-hand side of the recording. This will 
clear it forever. 
 
Use the same test recording process as described above in this 
section.

 
 
This is a better looking recording. There is no clipping. What we are aiming for is 
a recording where we are getting as louder recording as we can get without 
causing clipping.  
 
Experiment with the slider control until you get it just right. Remember to sing at 
the same level that you would in a normal performance. If you are still having 
trouble getting the level right then, you want to try moving closer or further away 
from the microphone.  
 
 
 

3.6  Test Recording from the line input 

The line input is where you can plug in virtually any other electronic musical 
device. Remember to set the output volume of the device to a low level and it is 
safer to make connections while the device is switched off.  
 

3.6.1 Test Recording 

The process for making a test recording of the instrument is similar to the making 
a test recording of the microphone above. Follow the steps below: 
 

1. Start Audacity  
2. Choose the Line-In as the recording source. [Picture] 
3. Set the recording input level to about half way. Note: the picture on this 

control is of a microphone even though it is for the line input in this case. 
4. Set the output level of the device you are recording to about half way. 

Note: your device may not have an output level setting.  
5. Press the red Record Button. 
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6. Play the instrument for a few seconds.  
7. Push the stop button 

 
 
 

3.6.2 Adjusting the levels 

We want to record the sound as loud as possible without causing clipping. So we 
need to repeat steps 5 to 7 several times until we get it just right. As you repeat 
the above process, you will need to increase the recording input level and/or the 
output volume of the device each time.  
 
If your first test recording resulted in clipping then you will then need to decrease 
the recording input level and/or the output volume of the device. 
 
Remember to clear the previous recording that was made. Click the x on the top 
left-hand side of the recording.  
 
Below are some waveforms of the same drum loop recorded at different input 
recording levels. 
 

 
The input recording level was set too low here.  
 

 
The input recording level was set too high. Clipping is occurring at the top and 
bottom of the waveform. 
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The input recording level is still set too high. There is a small amount of clipping 
occurring at the top and bottom of the waveform. 
 

 
This recording is good. The waveform shows no clipping and the volume is at a 
reasonable level to work with.  
 
 

3.7 Creating a Click Track 

The first layer that you should create should be the click track. A click track is 
simply just a metronome that will help you keep everything in time. Audacity lets 
you generate a click track for your project very easily. Here’s how you do it.  
 

1. Click the ‘Generate’ Menu 
2. Click ‘Click Track’ 
3. Set the tempo of your click track. This is in Beats per minute (BPM). 
4. Set the Beats per measure.  
5. Set the Number of measures. This is the number of bars in your song. You 

should add a least one extra measure so that you can use this as a count 
in to your song.   
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Listen to the click track and Count 1-2-3-4 (if you set the Beats per measure to 
4). The 1 beat is accented for you. You can remove the click track once all of 
your other layers of audio are recorded.   
 
A click track may not be necessary depending on the type of music you are 
creating. You may find that a click track may force you to play your music in a 
less organic way. Use your judgment. Ask yourself: Will a click track help or 
hinder my recording project? 
 
Some songs have changes in tempo throughout.  One click track will be useless 
in this situation. You may want to have several different layers of click tracks for 
the different tempos.  
 

3.8 Recording a guide track 

A guide track is a low quality recording of the song which is used as a guide 
while recording the good layers of the track. It can be used as an alternative to a 
click track or metronome. Simply record a live session of most of the musicians 
playing which just a microphone. 
 

1. Choose the microphone as the recording source. [Picture] 
2. Press the red Record Button. 

 
3. Perform the song. 
4. Push the stop button 
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3.9 Recording your layers 

Now we are up to the part where we will record something for real. Follow this 
process for each of your layers. 
 

1. Choose the appropriate input as the recording source. [Picture] 
2. Press the red Record Button. When this is pushed you will here the 

existing layers of your recording play. IE your click track or guide track 

 
3. Play the instrument or sing for the duration of the song. (note if recording 

into the microphone. You should use headphones to listen to the guide 
track or metronome. As you don’t want this to be picked up by the 
microphone.  

4. Push the stop button 

 
 
Simply repeat this process for each part of your recording. When you have 
finished recording all layers, you can mute your guide and click tracks. Some 
tracks will need to be deleted and rerecorded until you are satisfied. These 
techniques are described below. 
 

3.9.1 Listening to previously recorded tracks while recording 

There is a setting in Audacity which lets you enable/disable this feature. Follow 
these steps: 

1. Click the ‘File’ menu 
2. Choose ‘Preferences…’ 
3. Choose the ‘Audio I/O’ tab. 
4. Click the checkbox titled ‘Play other tracks while recording new one’.  

 
 

3.9.2 Deleting tracks 

Deleting a track is as easy as clicking the X on the top left corner of the track 
window. If you delete a track by mistake you can undo it by clicking ‘Undo’ from 
the ‘Edit’ menu. 
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3.9.3 Muting tracks 

You can mute a track by clicking the ‘Mute’ button on the track window. This will 
make this track silent while other tracks play. 

 
 

3.9.4 Soloing tracks 

You choose to listen to one track while muting all others by clicking the ‘Solo’ 
button on the track window.  

 
  
 

3.10  Mixing 

Mixing is the part of the process where you modify the individual layers of the 
audio to get everything sound just right.  
 
One of the most basic things that you will do layers will be to increase or 
decrease the volume so that it sounds good with the other layers of audio. 
 
You can always use the some of the more advanced features of audacity to 
make your recording sound more exciting. For example you can add echoes, 
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delay, bass boost and much more. Have a look in the effect menu to see what is 
available.  
 
No that you have recorded all of your layers, you should play your recording and 
listen carefully. Write a list of things that need attention. Does anything need to 
be re-recorded? Or can it be fixed now.  
 
Here is a list of some of the effects that you may wish to apply when mixing your 
recording.  
 

• forcing unwanted sounds to silence 
• increasing/decreasing volume levels of layers 
• fading out layers 
• fading in layers 
• equalization 
• noise removal 
• high or low pass filtering 
• compression 
• normalizing layers  

 
 
 

3.10.1 Forcing unwanted sounds to silence 

Audio can be forced to silence by first selecting the audio you want to silence. 
You will probably want to zoom in so that you don’t silence more than you intend 
to.  
 

1. Click the ‘Edit’ Menu 
2. Click ‘Silence’ 

 
You will notice that the section of the layer that you selected will now be flat lined.  

3.10.2 Adjusting volume of layers 

There are a variety of ways of adjusting the volume (amplitude) of layers. See the 
section below on compression, normalization also. The most basic way of doing 
this is with the ‘Amplify’ effect. This effect can also be used to make the selection 
quieter.  
 
Select the section of audio on the layer of audio that you want to apply the 
Amplify effect to.  
 

1. Click the ‘Effect’ Menu 
2. Click ‘Amplify’ 
3. Adjust the slider to the level you want. 
4. Click ‘OK’.  
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Notice that if the box titled ‘Don’t Allow Clipping’ is selected, The OK button will 
be disabled if you try to amplify the audio too much.  
 

3.10.3 Fading out layers 

Fading out is a common effect used in audio editing. Select the section of audio 
on the layer of audio that you want to apply the ‘Fade Out’ effect to.  
 

1. Click the ‘Effect’ Menu 
2. Click ‘Fade Out’ 
3. Click ‘OK’.  

 
You will be able to see the amplitude (volume) of the waveform gradually 
decrease until it is silent.  
 

3.10.4 Fading in layers 

This works exactly the same was as Fading In except it’s the opposite. Select the 
section of audio on the layer of audio that you want to apply the ‘Fade In’ effect 
to.  
 

1. Click the ‘Effect’ Menu 
2. Click ‘’Fade In’ 
3. Click ‘OK’.  

 
You will be able to see the amplitude (volume) of the waveform start from silence 
and gradually increase to the amplitude of the rest of the waveform.  
 
 

3.10.5 High or low pass filtering 

Filtering is where you are removing high or low pitch parts of the sound. There 
are a few reasons where you might want to use filtering. A high pass filter is 
useful for removing the ‘ess’ sounds from vocal recordings and some wind 
instruments.  Ess  
 
[More Research here use the recorder] 
 

3.10.6 Compression 

Compression is also known as dynamic range processing or variable gain 
amplification. The purpose of compression is to make the sound level of the 
recording as consistent as possible.  
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Compression is where the volume level is reduced or increased automatically 
depending on the actual level of the recording at the time. Compression is an 
especially useful effect to apply to layers recorded through a microphone. Say 
you are recording vocal and there is a part in the recording where the vocalist 
was not loud enough. Compression can be used to bring up the volume of the 
recording to a set level. Or say the vocalist sang too loud in one part. 
Compression could bring this volume down to the set level.  
 
Basically a compressor can be set up to reduce the gain when the input level 
increases. And the compressor can be set up to automatically increase the gain 
when the input level decreases.  
 
Compression is not an easy effect to use. It can often be misused and make the 
recording sound very bad. It is best to gain a good understanding of how and 
when to use compression before attempting to use it. 
 
Audacity lets control compression with Threshold, Attack and Ratio settings and 
the option to apply gain after compression. 
 
There is a checkbox labeled ‘Apply Gain after compressing’. For now it is best to 
leave this box unchecked.  
 
Threshold is the setting that determines when compression is applied. The units 
for this setting are in negative dB (decibels). The loudest dB is 0(zero) so any 
level below this is displayed in negatives. If you set the Threshold to -10 dB, then 
any sound above this level will be reduced at level as determined by the ratio 
setting. Sounds that are quieter than -10 dB will not be compressed. 
 
Ratio is the setting that determines how much the sound above the threshold will 
be reduced. So if the input level is -10 dB, above the threshold of -5 dB and the 
ratio is set to 2:1 then the output level will be reduced to -7.5 Db. The formula 
looks like this: 

 
Output Level = ((Input Level - Threshold) / Ratio) + Threshold 

 
There are different ratio settings that you can use. Ratios from 1.5:1 to 6:1 
provide soft compression. Anything above 6:1 is considered hard compression. It 
is also called limiting. Limiting is where sound will not be output above a certain 
level. If you are intending on using ‘hard limiting’ you should set the ratio and 
threshold to a high level. You should also set the attack time to 0.1 seconds.  
 
 
Attack time is the time in which compression is applied (or not applied) to the 
input signal. If you set your threshold to -6 dB and your Attack time 0.3 seconds. 
Then it will take 0.3 seconds for compression to be applied once the sound level 
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reaches -6 dB. Once the input level goes below -6 dB again, it will take 0.3 
seconds for compression to cease.  
 
 
To apply compression, select the section of audio on the layer of audio that you 
want to apply the ‘Compressor’ effect to.  
 

1. Click the ‘Effect’ Menu 
2. Click ‘Compressor’ 
3. Uncheck ‘Apply Gain after compressing’ 
4. Set the ‘Threshold’ 
5. Set the ‘Ratio’ 
6. Set the ‘Attack Time’ 
7. Click ‘OK’.  

 
 
It will take a lot of trial and error to get the compressor to do what you want it to. 
Compression is a fine art to master.  
 
 
 

 

3.11 Duplicating your track 

You’re at the stage where your track is sounding good and you want others to 
hear it. There are a variety of ways that you can distribute your recording. And 
there are primarily three formats you way want to use: 
 

• Mp3  
• Audio CD 
• Cassette tape. 

 
Mp3 is what you will use if you want to email your track to anyone. There are 
many mp3 upload websites designed for recording artists to promote their work.  
 
Audio CDs are what you will use if you are intending to post you CD to 
somebody. 
 
You will use a cassette tape if the above options are not available to you. The 
sound quality of your recoding will be reduced once you record to an analog 
medium.  

 

3.11.1 Encoding to MP3 

By default Audacity does not come with support for MP3 exporting. However you 
can enable this feature by loading in a module called ‘lame_enc.dll’.  
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To export you track to MP3: 
Click ‘File’ menu 
Click ‘Export As MP3…’ 
Fill out the details of your MP3 file. This information goes into the ID3 tag of the 
MP3 file which is then displayed in MP3 players when it is played. 
 
You may be asked to load the lame_enc.dll file at this point. If so follow these 
steps: 
 
Download lame_enc.dll from the internet. You’ll find it on Google. 
Save the file to your computer. Take note of where you save it. 
When Audacity asks for this file, Browse to it and click Open.  
 

3.11.2 Making Cassettes 

 
To record to cassette you will need a cassette recorder that can record from line 
inputs. Most mini-system or component stereo systems have this feature.  
 
Recording to cassette can be done by connecting your mini-system to the output 
of your sound card.  
 
You will simply need to choose auxiliary/video in on your mini-system and press 
record. Then click play on your recording. 
 
If you are making a cassette of several songs it would be a good idea encode the 
songs to MP3 first and then create a playlist of your tracks in an MP3 player such 
as Winamp (website here).  
 
If you record from the computer to cassette then you will need to experiment the 
output level of the computer. You should use the mixer setting of your soundcard 
for this. 
 
Double click the speaker icon on the bottom right of your screen and set the 
master level to about 90%. Record your tracks. 
 
Once your tape is made, test it out on a variety of different systems. How does it 
sound in the car, other stereos and through headphones? Was it too loud? Or 
could it be made louder? If so adjust the output level and try again. 
 
Alternatively you could put your tracks on a CD and just record the CD to 
cassette on your mini-system. You won’t need to worry about output levels as 
described above. 
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3.11.3 Creating an Audio CD 

Once you have mastered your tracks it is very easy to make an audio CD with a 
CD writer. Just about all CD writers sold today come with software to make audio 
CDs. The two main programs bundled with CD writer are Ahead Nero and 
Adaptec Easy CD creator.  
 
You can make a CD with mp3 files or wav files. It is best to make CD from wav 
files because MP3 files are compressed and the audio quality is not as good as a 
16bit, 44100 Hz wave file.  
 
Refer to the documentation of your CD writer software to see how to compile an 
Audio CD.   
 

 

4 Distributing your recording 
Your demo is made. Now you need to get it heard. There are many was of doing 
this. This chapter briefly discusses some of these. You are bound to have your 
own ideas about this, but this chapter may give you some ideas.  
 

4.1 Mp3 upload websites 

There are many great websites where you can upload your music for all to 
download. There are even sites where you can sell your music minus a small 
commission. Mp3 upload sites often come and go, so see what is currently 
available, just Google mp3 indie upload or similar key words. There will be plenty 
to choose from. Some mp3 upload sites specialize is certain genres or music 
from different countries. Sign up to as many as your music is appropriate for. It is 
all good exposure. Most Mp3 upload sites should allow you create a profile about 
you or your band and upload images. MySpace.com is good start. 

 
 

4.2 A&R Sites 

There are many A&R directories available on the internet. You just need to 
search for them. There are many choose from. Also try searching for genre 
recording label in Google. Replace the word genre for whatever style of music 
yours is.  There are also many articles that give you a few good clues for 
submitting your demo. Apparently most demos end up in the bin. So you 
shouldn’t rely on just talent and a good recording. Good presentation is 
important.   

 
 


